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Ultimaker Original Assembly manual

Dear customer,

Thank you for purchasing the Ultimaker Original DIY kit and welcome to our community!
This assembly manual will guide you through the build process step by step.
During the excitement of the build process you learn more and more. This will
help you understand the workings of a 3D printer even better and give you the
opportunity to get the most out of your Ultimaker.

Besides this assembly manual there’s also a user manual available online:
www.ultimaker.com/pages/support/manuals

Meet other Ultimaker users at our community forum: www.ultimaker.com/forum
Visit YouMagine for fun projects and free printable models: www.youmagine.com

Happy building and printing and we’ll be in touch!

Team Ultimaker

Contact information

We would love to hear from you. We are easy to reach and enjoy answering all
your questions. Technical assistance, sales enquiries or general information, we
are there for you. Find the information below to contact us.

General info@ultimaker.com
Support support@ultimaker.com
Sales sales@ultimaker.com
Marketing/PR pr@ultimaker.com
Phone +31(0)345 712 017

Meet us online at:
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1 Introduction

1.1 Product description

The parts of the Ultimaker Original can only be used for assembling the
Ultimaker Original. An assembled Ultimaker Original can only be used for
3D printing of products.

Ultimaking LTD cannot be held liable for any damage caused by improper,
incorrect or unwise use. Please read this manual completely and make sure
you understand it.

1.2 Used symbols

A Warning! A warning indicates the risk of (serious) damage to the user or
the product if the user does not carry out the procedures with care.
Caution! A comment makes the user aware of possible problems

ﬂ Notice: A notice makes the user aware of convenient functions and
additional options.




2 Technical specifications

2.1 General product specifications

Product description

Name: Ultimaker Original
Model/type: Revision 4

Year of production: 2014

Dimensions (W x D x H) 357 x 342 x 388mm
Mass 9 kg

Technical specifications

Power source 1OV or 230 V

Operating system: Windows, MAC and Linux

Speed: Max. head travel speed between
30mm/s - 300mm/s.

Accuracy: Positioning < 0.05mm

Build volume (X.Y,Z): 210 x 210 x 205mm

Technology: FFF (Fused Filament Fabrication)

Ambient Operating Temperature: 15° - 32° C

Storage Temperature: 0° -32°C

2.2 Environmental conditions

The Ultimaker Original can only be used in a dry environment. The product
cannot be used in a humid environment and in an environment with lots of
UV light. Usage in other environments can result in unwanted effects on the
performance of the product.
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Precautions and safety instructions

Only use original accessories from the manufacturer.

The product should only be used for applications as described by
the manufacturer. All other applications are unprofessional and
considered dangerous. The manufacturer cannot be held liable for
damage resulting from errors, unintended or unprofessional use of
the device.

Do not install the product outdoors or in any place where it might
become wet.

Do not install the product in any place that might be exposed to
extreme heat or cold.

Keep the product out of reach of children.

Disconnect the device from all power sources before cleaning it.

Remove the adapter from the power outlet during storms, lightning
and whenever the product will not be used for a longer period of
time.

Install the product as indicated in this manual. If in doubt, consult a
recognized technician and always take account of local installation
codes and regulations.

The product should be kept out of direct sunlight.

The product must not be discarded as unsorted municipal waste, it
must be disposed of separately.

>B>bB B bbbk b P

Find out about the options in your region for disposing of the
product after use. Do not throw away electrical appliances or
components, but see whether the product (components) can be
turned in, recycled or reused.




4 Preparation before assembling

4.1 Engraving

All panels are marked with the side they belong to.

For all the panels except the FRONT panel and the BOTTOM panel, the
engraving face. The FRONT panel has the “Ultimaker” engraving facing
outward. The BOTTOM panel has the engraving facing downward.

4.2 Sanding

Before starting the assembly, you may want to sand the panels slightly to
remove any burn marks/blemishes from the laser cutting process. You can also
paint or stain your Ultimaker Original. Be aware that paint will not cover the
brown cutting edges very well.

5 What to expect reading the assembly
instructions

5.1 Structure of the assembly instructions

Before assembling the Ultimaker Original, separate sub assemblies have to be built.
The description of every sub assembly in this manual will contain:

* An overview of the needed tools;

* An estimation of the needed time to built the sub assembly;

e The steps;

Every step in this manual will be described using the following structure:
e Cautions and warnings (if applicable);

e The needed parts;

* The actions to perform the step.

To make this manual easy to understand, images are used as much as possible.




5.2 Different sides of the Ultimaker Original

In this manual, you will read about FRONT side, BACK side, LEFT side,
RIGHT side, TOP side and BOTTOM side. In image 1 these terms are clarified.

TOP side

BACK side

r

LEFT side

RIGHT side

FRONT side

BOTTOM side

image 1:  sides of the Ultimaker Original
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Assembling the Ultimaker Original

ASSEMBLING
THE FRAME

WHAT YOU’LL NEED TO BUILD
THIS SUB ASSEMBLY.

Time:
about 60 to 90 minutes

Tools:

hex key screwdriver (1,5mm)
hex key wrench (2mm)
5.5mm (M3) socket wrench or pliers

10



6.1.1. Step 1: Inserting the ball bearings
The following parts are needed in this step.

Letter

Description

Qnty.

FRONT panel

LEFT panel

RIGHT panel

BACK panel

QO 0o

ball bearings 8mm
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image 2.

parts needed for this step

Every panel needed for this step has two corresponding holes.
To place the ball bearings, perform the following actions:

Get a panel.
Place the ball bearings.

Make sure you place the ball bearings as deep as shown in image 3.

Repeat action 1 and action 2 for all panels.

Step 1: Inserting the ball bearings Assembling the frame

n



image 3. placing the ball bearings into the panel

6.1.2. Step 2: Mounting the limit switches

Warning! Do not strain the tapped thread on the inside of the switch

& housing by putting a lot of force on the bolts. All limit switches are
pre-tapped, you can fasten them directly with M3 bolts, no nuts
required here!

c Caution! Note that all wires of limit switches need to be twisted,
see image 4.

The following parts are needed in this step.

Letter | Description Qnty.
() |[FRONT panel 1
() |LEFT panel 1
(® |BACK panel 1
() |RED wired limit switches 2
(@ |BLUE wired limit switches 2
(® |BLACK wired limit switches 2
® |bolts M3 x 12mm 8
() |bolts M3 x 16mm 4
@ |washers 2

12 Step 2: Mounting the limit switches Assembling the frame
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image 4: parts needed for this step

The orientation of the limit switches are engraved on the panels, except for the
FRONT panel.

The machine has 6 limit switches:

2 with BLUE wires

2 with RED wires

1 with LONG BLACK wires

1 with SHORT BLACK wires

Step 2: Mounting the limit switches Assembling the frame




To mount the BLUE wired limit switches to the front panel, perform the
following actions:

1.  Place the BLUE wired limit switches as shown in image 5.

2. Attach each BLUE wired limit switch with two bolts M3x12mm.

image 5:  attaching the RED wired limit switches

To attach the RED wired limit switches on the left panel, perform the following
actions:

1.  Attach the RED wired limit switches as shown in image 6.

2. Attach each RED wired limit switch with two bolts M3 x 12mm.

image 6. attaching the BLUE wired limit switches

14

Step 2: Mounting the limit switches Assembling the frame




To attach the BLACK limit switch with LONG wires, perform the following
actions:

1.  Attach the BLACK limit switch with LONG wires as shown in image 7.

Fine tuning the position will be described in another part of this
manual.

2. Attach the BLACK limit switch with LONG wires.
Use two bolts M3 x 16mm and two washers.

image 7. attaching the BLACK wired limit switch with LONG wires

Step 2: Mounting the limit switches Assembling the frame

15



To attach the BLACK wired limit switch with SHORT wires, perform the
following actions:
1. Place the BLACK wired limit switch with SHORT wires as shown in
image 8.
Fine tuning the position will be described in another part of this
manual.
2. Attach the BLACK wired limit switch with SHORT wires.
Use two bolts M3 x 16mm.

1-2mm

image 8: attaching the BLACK wired limit switch with SHORT wires

6.1.3. Step 3: Assembling the X and Y motor
The following parts are needed in this step.

Letter | Description Qnty.

LEFT panel 1

BACK panel 1

motors with long wires and rounded axles

black spacers

short timing belts

pulleys with a 5mm internal diameter

© PV EeO e

2
8
M3 washers 8
2
2
8

bolts M3 x 20mm

16 Step 3: Assembling the X and Y motor Assembling the frame
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image 9:

parts needed for this step

To assemble the Y motor, perform the following actions:

1.

Place the pulley (5mm internal diameter) on the Y motor, see image 10.
When placing, make sure to keep a distance of 1-2mm between the
pulley and the Y motor.

Place the timing belt around the pulley, see image T1.

Attach the Y motor on the LEFT panel with Y motor engraved on the
inside,

see image 12.

Notice: Do not attach the X motor and Y motor too tight. The X motor
and Y motor must be able to move up and down.

Notice: Place the X motor and Y motor in position that the wires face
down in direction of the text.

To assemble the X motor repeat action 1-2.

Make sure to attach the X motor on the BACK panel with X motor
engraved on the inside.

Step 3: Assembling the X and Y motor Assembling the frame
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image 10. placing the pulley on the Y motor axis

image 1. placing the timing belt around the pulley

18 Step 3: Assembling the X and Y motor Assembling the frame




image 12:  attaching the Y motor on the LEFT panel

6.1.4. Step 4: Preparing the BOTTOM panel
The following parts are needed in this step.

Letter | Description Qnty.
® |[BOTTOM panel 1
() |pieces of Velcro 4
® |bolts M3 x TOmm 4
() |motor with short wires and rounded axles 1
® |coupling 1

Step 4: Preparing the BOTTOM panel Assembling the frame 19




image 13: parts needed for this step

To prepare the BOTTOM panel, perform the following actions:
1.  Move 4 pieces black Velcro through the 4*2 slots of the
BOTTOM panel, see image 14.
Make sure the soft side is facing itself after placing.
2. Attach the Z-motor, see image 15.
Attach the motor such that the wires face out towards the center
of the BOTTOM panel.
3. Attach the coupling on the motor axis.
The 5mm opening of the coupling has to face towards the motor.
4. Tighten the screws, see image 16.
Make sure there’s a little space between the coupling and the
BOTTOM panel.
ﬂ Use the 1,5 mm hex key as a guide.

20 Step 4: Preparing the BOTTOM panel Assembling the frame




image 15. attaching the motor

Step 4: Preparing the BOTTOM panel Assembling the frame 21




image 16: placing the coupling and tightening the screws

6.1.5.

Step 5: Assembling the ‘cube’-shaped frame

The following parts are needed in this step.

Letter | Description Qnty.
panels (TOP, BOTTOM, FRONT, LEFT, BACK and RIGHT) 6
(d |SHORT cable ducts 2
() |LONG cable ducts 2
® |blue Scotch tape 1
() |bolts M3 x 16mm 37
® |hexnuts 3mm 37

22
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image 17:  parts needed for this step

Warning! Be careful not to put any force on the panels because they
are weak in this configuration; however they will become very sturdy
once you mount a few more panels.

To assemble to ‘cube’-shaped frame, perform the following actions:

o s RS

(for action 1-5 see image 18)

Place the BACK panel on the table.

Make sure the markings are facing towards you.

Put the TOP panel, with the markings downwards, into the BACK panel.
Put the BOTTOM panel into the BACK panel.

The 3 holes in the top panel must be on the side of the back panel.
Put the FRONT panel in the TOP and the BOTTOM panel.

Attach the four panels.

Use thirteen bolts M3 x 16mm and thirteen hex nuts 3mm.

Notice: loose fixation is highly recommended. You can tighten later.
Notice: if you attach the hex nuts, it can be helpfull to use some tape
to keep them in position.

Notice: make sure no cables get jammed before tightening.

Step 5: Assembling the ‘cube’-shaped frame Assembling the frame

23



image 18:

attaching the BACK, TORP BOTTOM and FRONT panel

(for action 6-8 see image 19)
6. Place a SHORT cable duct on the RIGHT side of the BACK panel.
7. Fold the SHORT cable duct.
8. Tape the folded SHORT cable duct (to keep it folded).
ﬂ Notice: make sure the blue Scotch tape can be removed easily.

image 19:

attaching and folding the SHORT cable duct

(for action 9-14 see image 20)
9. Place a LONG cable duct on the RIGHT side of the FRONT panel.
10. Fold the LONG cable duct.
1. Tape the folded LONG cable duct (to keep it folded).
ﬂ Notice: make sure the blue Scotch tape can be removed easily.
12. Place the RIGHT panel.
13. Attach the RIGHT panel.
Use twelve bolts M3 x 16mm and twelve hex nuts 3mm.
14. Remove the blue Scotch tape.

24
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image 20. placing and folding the LONG cable duct and placing the RIGHT panel

15.
16.

17.

18.
19.

20.

(for action 15-20 see image 21)

Turn the Ultimaker Original on it’s RIGHT side.

Place the second SHORT cable duct on the LEFT side of the BACK
panel, fold it and tape it.

Place the second LONG cable duct on the LEFT side of the FRONT
panel, fold it and tape it.

Place the LEFT panel.

Attach the LEFT panel.

Use twelve bolts M3 x 16mm and twelve hex nuts 3mm.

Remove the blue Scotch tape.

Step 5: Assembling the ‘cube’-shaped frame Assembling the frame

25



image 21: positioning the other SHORT and LONG cable ducts and attaching the
LEFT panel

\\

image 22: complete the frame by checking if all the bolts are tightened

26 Step 5: Assembling the ‘cube’-shaped frame Assembling the frame




21. Move the wires of the limit switches through the cable ducts.
ﬂ Notice: try to guide the endstop cables behind the y motor.
22. Move the wires of the X- and Y motor through the cable ducts.
23. Complete the frame, see image 22.

Use twelve bolts M3 x 16mm.

Well done, the frame should look like this (see image 23).

image 23 result assembling the ‘cube’-shaped frame

6.1.6. Step 6: attaching various parts
The following parts are needed in this step.

Letter | Description. Qnty.

wooden part 11A 1

(A

() |wooden part 3A 2
bolts M3 x 16mm 6

(C_

() |hex nuts 3mm 4

® |lock nuts M3 2

Step 6: attaching various parts Assembling the frame 27
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image 24 parts needed for this step

To attach the various parts, perform the following actions:

1. Attach wooden part 1A, see image 25. Make sure the lock nuts M3 are
attached on the outside.
Use two lock nuts M3 and two bolts M3 x 16mm.

2. Attach two wooden parts 3A to the bottom of the machine.
Use two bolts M3 x 16mm and two lock nuts M3 for each wooden
part 3A.

ﬂ Notice: wooden part 3A is 6mm thick, NOT 4mm.

28
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image 25: attaching part 11A

image 26. attaching wooden parts 3A

Great work! The frame is now ready! On to the next section.

Step 6: attaching various parts Assembling the frame

29



_ ASSEMBLING
" THE X/Y AXES

WHAT YOU’'LL NEED TO
ASSEMBLE THE X/Y AXES.

Time:
about 60 to 90 minutes

Tools:

hex keys (2mm)
hex keys (1,5mm)

30



6.2.1. Step 1: Assembling the FRONT, BACK, RIGHT, LEFT slider
blocks
The following parts are needed in this step.

Letter | Description. Qnty.

sliderblock parts 6mm 12 x

d t TA 20
o wooden par sliderblock part 4mm 8 x
() |linear bearings 4
FRONT slider |LEFT slider RIGHT slider BACK slider
block block block block
(A °@° a 9 /°) a s [°) a °®° a
Iil B© ° s® o of I
s b a b o b = b
O ¥ 3 Q)
= [ O, O, I— e
C C c
° ©a OO [ OO ] e®e
T AN
°©° d q &2 d 9 |2 d d
e g sO © BQ -]
Q o) e e e fe 2 e
O = - 9
@ S e o eQe lo
@ D f B f D f D f

image 27: parts needed for this step

To assemble the FRONT, RIGHT, LEFT, BACK slider blocks, perform the
following actions:
1. Push the bearing through the wooden parts, see image 28.
Make sure the bearing sticks out both sides of the FRONT slider block
(approx. T mm)

image 28 assembling the FRONT slider block

Step 1: Assembling the FRONT, BACK, RIGHT, LEFT slider blocks Assembling the X/Y axes




2. Do the same for the RIGHT, LEFT, and BACK slider blocks. Make sure

the order of the wooden parts are correct.

FRONT slider block

LEFT slider block

RIGHT slider block

BACK slider block

image 29: Result assembling FRONT, LEFT, RIGHT and BACK slider blocks

6.2.2. Step 2: Attaching the claws
The following parts are needed in this step.

Letter | Description Qnty.
(A FRONT, LEFT, RIGHT, BACK slider blocks 4
() |bolts M3 x TOmm 8
O 4mm wooden parts marked C 4
() |hex nuts 3mm 24
(® |bolts M3 x 30mm 12
( |wooden parts marked C 4

32 Step 2: Attaching the claws Assembling the X/Y axes
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image 30: parts needed for this step

To attach the claws, perform the following actions:

1.

i |
2.
3,
4.
i |

Attach the bolt to the wooden part marked C, see image 31.

Use one bolt M3 x 10mm and two hex nuts 3mm.

Notice: the last hex nut will barely fit in. This is normal.

Place the wooden part marked C in the FRONT slider block.

Place three bolts M3 x 30mm, see image 32.

Attach the nuts, see image 32.

Notice: do not tighten the nuts too much. The claw must be able to
rotate.

Repeat action 1-5 three times to attach all wooden parts marked C on
all slider blocks.

Assemble the 4mm wooden parts, marked C, see image 33.

Use one bolt M3 x 10mm and one nut.

Notice: this assembled wooden parts, marked C will be used later.

image 31: attaching the bolt to the wooden part marked C

Step 2: Attaching the claws Assembling the X/Y axes 33
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image 32: placing the wooden part marked C in the FRONT slider block

image 33. assembling 4mm wooden parts marked C

6.2.3. Step 3: Mounting the caps
The following parts are needed in this step.

Letter | Description Qnty.
® |wooden end caps WITHOUT hole 8
() |wooden caps WITH hole 6
® |bolts M3 x 16mm 16
() |hex nuts 3mm 16

34
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image 34: parts needed for this step

The wooden caps have to be attached in four corners of the Ultimaker Original.
To help you performing the actions, the following overview is provided, see
image 35.

image 35. overview different corners

Step 3: Mounting the caps Assembling the X/Y axes




To attach the wooden caps, perform the following actions:

1.

Attach the wooden caps in corner A, see image 36.

The wooden caps WITH hole on the inside, the wooden end caps
WITHOUT hole on the outside.

Notice: Use two bolts M3 x 16mm and two hex nuts 3mm at both
panels.

image 36: attaching the wooden caps in corner A

Attach the wooden caps in corner B, see image 37.

The wooden caps WITH hole on the inside, the wooden end caps
WITHOUT hole on the outside.

Notice: Use ONE bolt M3 x 16mm and ONE hex nut 3mm at the RIGHT
panel.

Use two bolts M3 x 16mm and two hex nuts 3mm at the FRONT panel.

image 37: attaching the wooden caps in corner B

36
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Attach the wooden caps in corner C, see image 38.

The wooden caps WITH hole on the inside, the wooden end caps
WITHOUT hole on the outside.

Use ONE wooden end cap WITHOUT hole at the BACK panel.

Notice: Use ONE bolt M3 x 16mm and ONE hex nut 3mm at the RIGHT
panel.

Notice: Use ONE bolt M3 x 16mm and ONE hex nut 3mm at the BACK
panel,

image 38: attaching the wooden caps in corner C

4.

Attach the wooden caps in corner D, see image 39.

The wooden caps WITH hole on the inside, the wooden end caps
WITHOUT hole on the outside.

Use ONE a wooden end cap WITHOUT hole at the LEFT panel

Notice: Use ONE bolt M3 x 16mm and ONE hex nut 3mm at the BACK
panel,

Notice: Use two bolt M3 x 16mm and two hex nuts 3mm at the LEFT
panel.

Step 3: Mounting the caps Assembling the X/Y axes
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image 39: attaching the wooden caps in corner D

6.2.4.

Step 4: Mounting the axes

The following parts are needed in this step.

Letter | Description Qnty.
FRONT, LEFT, RIGHT, BACK slider blocks 4

@ |[timing belts 4
() |axes SHORT 2
(® |axes LONG 2
() [timing pulleys 10

0 L ¢ 4 x

O 2 x

® ( 2x

@ E 10 x

image 40: parts needed for this step
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To help you performing the actions, the following overview is provided, see
image 41.

BACK

image 41: overview of the LEFT, RIGHT, BACK and FRONT axes

To attach axis FRONT (SHORT) perform the following actions:

1.  Get axis SHORT

2. Rotate the wooden end cap WITHOUT hole (RIGHT panel, FRONT), see
image 42.

3.  Put the pulleys on the timing belts.
Use ONE timing pulleys for each timing belt.

ﬂ NOTICE: the thinnest side of the timing pulley is facing to the outside.

4. Move the axis SHORT from the RIGHT panel to the LEFT panel, see
image 44.
Place the following five parts, in order, on the axis SHORT:
- timing belt with ONE timing pulley.
- FRONT slider block.

ﬂ NOTICE: the clamp of the FRONT slider block is facing downwards
along the FRONT panel, see image 43.
- timing belt with ONE timing pulley.

5. Rotate the wooden end cap WITHOUT hole (RIGHT panel, FRONT)
back to its normal position.

6. Attach the wooden end gap WITHOUT hole with a bolt M3 x 16mm
and a hex nut 3mm.

Step 4: Mounting the axes Assembling the X/Y axes
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image 42: rotating the wooden end cap |image 43: Side view FRONT slider block

WITHOUT hole

image 44.: attaching the FRONT axis

To attach the axis BACK (SHORT) perform the following actions:

1.

2.
3.

Get a axis SHORT.

Rotate the wooden end cap WITHOUT hole (RIGHT panel, BACK).
Put the pulleys on the timing belts.

Use ONE timing pulley for each timing belt which is connected to axis
SHORT (FRONT panel).

Use ONE timing pulley for the timing belt which is connected to the
motor.

NOTICE: the thinnest side of the timing pulley is facing to the outside.
Move the axis SHORT. from the RIGHT panel to the LEFT panel, see
image 45.

Place the following five parts, in order, on the axis SHORT:

- timing belt which is connected to axis SHORT (FRONT panel) with
ONE timing pulley.

- BACK slider block.

- timing belt which is connected to axis SHORT (FRONT panel) with
ONE timing pulley.

- timing belt which is connected to the motor with ONE timing pulley.

40
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NOTICE: the clamp of the BACK slider block is facing downwards
along the BACK panel

- timing belt which is connected to axis SHORT (FRONT panel) with
ONE timing pulley.

Rotate the wooden end cap WITHOUT hole (RIGHT panel, BACK) back
to its normal position.

Attach the wooden end cap WITHOUT hole with ONE bolt M3 x 16mm
and ONE hex nut 3mm.

image 45: attaching the BACK axis

To attach the Axis Left (LONG) perform the following actions:

Get an Axis (LONG).

Rotate the wooden end cap WITHOUT hole (BACK panel, LEFT).
Put the pulleys on the timing belts.

Use ONE timing pulley for each timing belt.

NOTICE: the thinnest side of the timing pulley is facing to the outside.

Move the axis LONG from the BACK panel to the FRONT panel, see
image 46.

Place the following five parts, in order, on the axis:

- timing belt with ONE timing pulleys.

- LEFT slider block.

NOTICE: the clamp of the LEFT slider block is facing upwards along
the LEFT panel.

Step 4: Mounting the axes Assembling the X/Y axes
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- timing belt with ONE timing pulleys.

5. Put the timing belt in the FRONT slider block, see image 47.

Put the timing belt in the BACK slider block, see image 48.

7. Rotate the wooden end cap WITHOUT hole (BACK panel, LEFT) back
to its normal position.

8. Attach the wooden end cap WITHOUT hole with a bolt M3 x 16mm and
a hex nut 3mm.

o

image 47: attaching the FRONT slider block on the timing belt

image 48 attaching the BACK slider block on the timing belt
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To attach axis RIGHT (LONG) perform the following actions:

1.

2.
3.

Get a axis LONG.

Rotate the wooden end cap WITHOUT hole (BACK panel, RIGHT).

Put the pulleys on the timing belts.

Use ONE timing pulley for the timing belt which is connected to the
motor.

Use ONE timing pulley for each timing belt which is connected to axis
LONG (LEFT panel).

NOTICE: the thinnest side of the timing pulley is facing to the outside.

Move the axis LONG from the BACK panel to the FRONT panel, see
image 49.

Place the following five parts, in order, on the axis LONG:

- timing belt which is connected to the motor with timing pulley.

- timing belt which is connected to axis LONG with ONE timing pulley.
- RIGHT slider block.

NOTICE: the clamp of the RIGHT slider block is facing upwards along
the RIGHT panel.

- timing belt which is connected to axis LONG (LEFT panel) with ONE
timing pulley.

Rotate the wooden end cap WITHOUT hole (BACK panel, LEFT) back
to its normal position.

Attach the wooden end ap WITHOUT hole with a bolt M3 x 16mm and
a hex nut 3mm.

image 49: attaching the RIGHT axis

Step 4: Mounting the axes Assembling the X/Y axes
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 ASSEMBLING
THE EXTRUSION
HEAD

WHAT YOU'LL NEED
TO ASSEMBLE
THE EXTRUSION HEAD.

Time:
about 60 to 90 minutes

Tools:

hex keys (2mm)

hex keys (1,5mm)

pliers

small screw driver (1,5mm)
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6.3.1.

Step 1: Assemble the extrusion head housing
The following parts are needed in this step.

Letter | Description Qnty. | Letter | Description Qnty.
® |spiral wrapping 1 () |cartridge heater 1
() |Thumb screw 4 ® |[thermocouple 1

. wooden part FRONT,
brass pipe 1 4
C PP @ |5ack LEFT, RIGHT
() |teflon tube 1 ® |wooden part 8B 1
GO |peek 1 @ |aluminium plate 1
aluminium heater
1 wooden part TOP 1
@ piock o P
® |nozzle T @ |blue horse shoe 1
WHITE bowden tube
linear bearin 1 1
o d o clamp
black injection
threaded spacers 2 1
“ P o moulded part
@® |hex nuts 3mm 6 (D |strain relief plate 1
(@ |bolts M3 x16mm 2 @ |amplifier board 1
® |bolts M3 x 12mm 1 @ |acrylic mounting plate 1
@ |bolts M3 x 10mm 7 @ |bowden tube 1

Step 1: Assemble the extrusion head housing Assembling the extrusion head
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image 50: parts needed for this step
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To assemble the extrusion head housing, perform the following actions.
1. Attach the nozzle into the aluminium heater block, see image 51.
ﬂ NOTICE: Attach the nozzle as tight as possible to the aluminium
heater block.
2. Attach the brass pipe into the aluminium heater block. see image 51.
ﬂ NOTICE: A space between the brass pipe and the alluminium heater
block is allowed, see image 52.

% brass pipe
.

-

nozzle

image 51: attaching the nozzle and brass pipe into the aluminium heater block.

===

v

image 52: result assembling the nozzle, brass pipe and aluminium heater block.

Place the linear bearing in the FRONT and the BACK sides of the extrusion
head housing, see image 53.
ﬂ NOTICE: make sure the linear bearing is sicking IN but NOT sticking
THROUGH the sides.
3. Place ONE linear bearing in the RIGHT and the LEFT sides of the
extrusion head housing, see image 53.
ﬂ NOTICE: make sure the linear bearing is sicking IN but NOT sticking
THROUGH the sides.

Step 1: Assemble the extrusion head housing Assembling the extrusion head 47




image 53: placing the linear bearings in the sides of the extrusion head housing

4. Attach the sides together, see image 54.
Use four bolts M3 x TOmm and four hex nuts 3mm.

5. Place the extrusion head housing into the wooden part 8B, see image
54,

image 54: attaching the sides together and placing into wooden part 8B.

6. Place the peek into the aluminium plate, see image 55.

ﬂ NOTICE: the aluminium plate is symmetric. You can choose any hole
you want.

7. Attach the peek into the brass pipe (keep the aluminium heater block
in position as shown), see image 55.

ﬂ NOTICE: Attach the peek through the aluminium plate to the brass
pipe as tight as possible.
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image 55: attaching the peek and the brass pipe through the aluminium plate

8. Attach the cartridge heater and the thermocouple through the
wooden part 8B, see image 56.
NOTICE: use the hole back RIGHT.

angle.

NOTICE: the thermocouple is the small 3 mm cylinder with an
aluminium sleve.

NOTICE: the cartridge heater is the small 6 mm cylinder with a right

image 56: moving cardrigde heater and thermocouple through the aluminium plate
and the extrusion head housing.

Step 1: Assemble the extrusion head housing Assembling the extrusion head
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9. Attach the thermocouple and cartridge heater in the back of the
aluminium heater block, see image 57.

10. Lock the thermocouple and cartridge heater.
Use ONE bolt M3 x 1TO0mm.

image 57: attaching the thermocouple and the cartridge heater

1. Insert the teflon tube in the wooden part 8B, see image 58.

image 58 attaching the teflon tube

50

Step 1: Assemble the extrusion head housing Assembling the extrusion head




12.

Attach the black injection moulded part on the wooden part marked
TOP, see image 59.

Notice: pay attention to how the part is positioned.

Use ONE M3 x 12mm bolt and a hex nut.

image 59: attaching the black injection moulded part on the wooden part TOP

13.

14.
15.
16.
17.
18.

(for action 15-19 see image 60)

Put two bolts M3 x 16mm through the bottom side of the wooded part
marked TOP.

Place the acrylic mounting plate over the two bolts M3 x 16mm.

Place the amplifier circuit board over the bolts M3 x 16mm.

Attach two threaded spacers over the two bolts M3 x 16mm.

Place the strain relief plate on top of the threaded spacers.

Lock by screwing two bolts M3 x 10 mm into the threaded spacers.

image 60: attaching the acrylic mounting plate, amplifier circuit board and strain relief

Step 1: Assemble the extrusion head housing Assembling the extrusion head
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19. Move the wires of the thermocouple, the cartridge heater and the
small fan through the middle hole of the wooden part TOP, see image
61.

image 61: moving the wires of the thermocouple, cartridge heater and the small fan
through the wooden part TOP

(for action 20-22 see image 63)

20. Attach WHITE bowden tube clamp in the front RIGHT hole of black
injection moulded part.

21. Move the Thumb screws through the corner holes.

22. Attach the Thumb screws. Do not attach the Thumb screws too tight.

image 62: Attaching the WHITE bowden tube clamp and the Thumb screws.

ﬂ NOTICE: keep a small gap between the wooden part and the
aluminium plate.

23. Move the bowden tube through the WHITE bowden tube clamp and
through the teflon tube.

ﬂ NOTICE: use the end of the bowden tube which has no blue tape..
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Tip: you can use a screwdriver to guide the bowden tube through the
teflon tube.

24. Lock the bowden tube, by putting the blue horse shoe under the
WHITE bowden tube clamp, see image 63.

ﬂ NOTICE: give some light pressure on the bowden tube while placing
the blue horse shoe.

25. Tighten the Thumb screws completely.

image 63: attaching the blue horse shoe

26. Place the RED wire of the thermocouple in the RIGHT socket and
screw till the wire is clamped.
Use a 2mm screwdriver.

27. Place the YELLOW wire of the thermocouple in the LEFT socket and
screw till the wire is clamped, see image 64.

frrr
i

i

 fe
N

N

RED wire

YELLOW wire

image 64. attaching the thermocouple wires in the socket

Step 1: Assemble the extrusion head housing Assembling the extrusion head




6.3.2. Step 2: cooling fan assembly
The following parts are needed in this step.

Letter | Description Qnty. | Letter | Description Qnty.
@® |cooling fan T ® |bolts M3 x 16mm 2
BLACK polypropylene
1 hex nuts 3mm 4
B fan duct o

| o

CJ (D)

image 65 parts needed for this step

To assemble the cooling fan assembly, perform the following actions.
1.  Fold the polypropylene fan duct, see image 66.

2. Attach the cooling fan on the BLACK polypropylene fan duct, see

image 66.
Use two bolts M3 x Temm and two hex nuts 3mm.

ﬂ Notice: make sure the wires are leaving the fan from side as shown in

image 66.
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image 66. attaching the fan on the BLACK polypropylene fan duct

3. Move the BLACK polypropylene fan duct on the bottom of the
extruder head, over two Thumb screws, see image 67.
4. Attach with two hex nuts 3mm.

image 67. attaching the BLACK polypropylene fan duct on the bottom of the

extruder head.

5. Fold the BLACK polypropylene fan duct together.

image 68. result assembling the cooling fan assembly.

Step 2: cooling fan assembly Assembling the extrusion head 55



6.3.3. Step 3: attaching the housing on the XY frame
The following parts are needed in this step.

Letter | Description Qnty. | Letter | Description Qnty.
Q X and Y axes 2 @ wooden parts C 4
() |bolts M3 x 30mm 4 O |spacers 2
® |hex nuts 3mm 4

( ) 2X

4 x © 4x ‘:F 4 x
1CJ [0

mmr\rvv\|2x

e

image 69: parts needed for this step

To attach the housing on the XY frame, perform the following actions.
1. Place a wooden part C into the LEFT slider block, see image 70.
ﬂ Notice: do not tighten yet.

image 70: moving the wooden part C in the LEFT slider block.

2. Move X and Y axes in the extuder head, see image 71.
ﬂ Notice: make sure the extruder head is placed inside the machine,
below the slider blocks.

Step 3: attaching the housing on the XY frame Assembling the extrusion head




Notice: make sure the FRONT side of the extruder head is faced to
the FRONT panel.

s ——— - - = —
I s!ﬂ:’l;‘ﬁ'ﬁ'ﬂ"?""y/ 7o
| 0o\ F/on 2°°
S T j f

image 71 moving the X and Y axes into the extruder head

3,
i |
4.
5.,
6.
i |

Move the X axis in the LEFT slider block, see image 72.

Notice: make sure the Y axis do not fall out.

Move the Y axis in the FRONT and BACK slider blocks, see image 72.
Turn the RIGHT slider block.

Move the X axis in the RIGHT slider block.

Notice: make sure the X and Y axis are placed in the right order in the
slider blocks to prevent the X and Y axis from bending.

Move the wooden part C in FRONT, BACK and RIGHT slider blocks.
Attach ONE bolts M3 x 30mm in each FRONT, BACK and RIGHT slider
blocks, see image 73.

Notice: do not tight the bolts M3 x 30mm yet.

Attach the wooden parts C.

Tighten the bolts M3 x 30mm

Notice: Do not force. Make sure the X and Y axis do not bend.

image 72: moving the X and Y axis into the slider blocks

Step 3: attaching the housing on the XY frame Assembling the extrusion head
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image 73: moving the wooden part C into the FRONT, BACK and RIGHT slider block
and attach with ONE bolt M3 x 30mm

To calibrate the XY-gantry perform the following steps:

1.  Align the X axis of the extruder head.
Use two spacers.

12. Tighten the timing pulleys which are attached to the LEFT timing belt,
see image 74.

ﬂ NOTICE: make sure the spacers use the same notch. Move the RIGHT
sliderblock in the correct position if needed.

13. Tighten the timing pulleys which are attached to the RIGHT timing
belt.

ﬂ NOTICE: use another notch if the timing pulleys can not be reached.

14. Repeat step 13 and 14 for the Y axis, FRONT timing pulley and BACK
timing pulley.

image 74: tighting the timing pulleys by using spacers
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image 75: adjusting the timing pulleys

15. Move the X motor down en keep it in position.
[I Notice: push gently, do not overdo.
16. Tighten the bolts, see image 76

17. Repeat step 14 and 15 for the Y motor.

0

N

image /6. tightening the bolts of the X motor.

18.

Move the extruder head all to the end of the X axis.
Notice: Make sure you hear the limit switch clicking.

If not: move the RED wired limit switch till the clicking sound occurs.
19. Tighten the RED wired limit switch.

20. Repeat step 19 and 20 for the BLUE wired limit switch.

Step 3: attaching the housing on the XY frame Assembling the extrusion head



 ASSEMBLING
THE Z STAGE

WHAT YOU'LL NEED
TO ASSEMBLE
THE EXTRUSION HEAD.

Time:
about 60 to 90 minutes

Tools:

hex keys (2mm)
small screw driver (1,5mm)

60



6.4.1. Step 1: Assembling the drive nut assembly
The following parts are needed in this step.

Letter | Description Qnty. | Letter | Description Qnty.

® |wooden parts 4 () |drive nut 1

0
(B)

L

éﬁﬂtnmaﬂé@r

E
5

image 77: parts needed for this step

To make the drive nut assembly, perform the following actions.
1.  Place the two smaller wooden parts arount the driver nut.
2. Place the bigger wooden parts, see image 78.

image 78: assembling the drive nut assembly.

Step 1: Assembling the drive nut assembly Assembling the Z stage




6.4.2. Step 3: LEFT and RIGHT arm assembly
The following parts are needed in this step.

Letter | Qnty. | Description Letter | Qnty. | Description
(A 16 | wooden panel (C) 14 | bolts M3 x 30mm
(B) 2 |linear bearings (D] 14 | hex nuts 3mm
LEFT arm RIGHT arm

O
O
—
N

(of
30
c /—l C l‘\ 5
C s <L
'010
il T
d d bl °)

&

()
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(0]
s
C

C . . ol
)
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f = — — ol | |[f oo )
(B
o 14X
o =
2x
L0/ | 14x

image 79: parts needed for this step

Step 3: LEFT and RIGHT arm assembly Assembling the Z stage




To assemble the LEFT arm, perform the following actions (for action 1-6 see
image 80).

1. Move seven bolts M3 x 30mm through the wooden part marked LEFT B.

Place a linear bearing on top of the wooden part marked LEFT B.
Place the parts marked LEFT C and C on top of part LEFT B.

On top of that, place the parts marked LEFT Dand D.

On top of that, place the parts marked LEFT E and E.

On top of that, place the parts marked LEFT F and F.

Attach the parts together.

Use seven hex nuts 3mm.

ﬂ Notice: it can take some force.

ﬂ Notice: Make sure to bolt tight.

N OO AW

image 80: assembling the LEFT arm.

To assembly RIGHT arm, perform the following actions.
(for action 7-12, see image 81)
1. Move seven bolts M3 x 30mm through the wooden part marked
RIGHT B.
2. Place a linear bearing on top of the wooden part marked RIGHT B.
3. Place the parts marked RIGHT C and C on top of part RIGHT B
4. On top of that, place the parts marked RIGHT D and D.

Step 3: LEFT and RIGHT arm assembly Assembling the Z stage
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5. On top of that, place the parts marked RIGHT E and E.
6. On top of that, place the parts marked RIGHT F and F.
7. Attach the parts together.

Use ONE hex nut 3mm.
ﬂ Notice: it can take some force.
ﬂ Notice: Make sure to bolt tight.

image 81: assembling the RIGHT arm

6.4.3. Step 2: inserting the adjustable level screws
The following parts are needed in this step.

Letter | Description Qnty. | Letter | Description Qnty.
® |wooden panel T G |hex nuts 3mm 8
() |bolts M3 x 30mm 4 @ |springs 4
® |washers 4 ©® |delrins 4
() |bolts M3 x 10mm 8

Step 2: inserting the adjustable level screws Assembling the Z stage
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image 82: parts needed for this step

To insert the adjustable level screws, perform the following actions.
(for action 1-3 see image 83)
1.  Place the delrins in each corner hole.
2. Attach the delrins.

Use two bolts M3 x TOmm and two hex nuts 3mm for each delrin.

3. Attach ONE spring and ONE washer together on each delrin.
Use ONE bolt M3 x 30mm.
ﬂ Notice: do not bolt tight.

image 83: attaching the adjustable level screws

Step 2: inserting the adjustable level screws Assembling the Z stage
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6.4.4. Step 4: finishing the Z stage assembly
The following parts are needed in this step.

Letter | Description Qnty. | Letter | Description Qnty.
® |LEFTarm 1 () |hex nuts 3mm 20
. wooden panel with
drive nut assembl 1 1
B4 Ve nu Y e adjustable level screws
® |[RIGHT arm 1 G |bolts M3 x 30mm 20

(B

) [m)

Ultimaker
[m ) [m]

©
0

&

image 84. parts needed for this step

To finish the Z stage assembly, perform the following actions (for action 1-3 see
image 85).
1. Put six hex nuts 3mm in the slots of the drive nut assembly,

2.
3.

Move the drive nut assembly in the RIGHT arm.
Bolt the parts together.

Tip: bolt crosswise.

Notice: bolt tight.
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image 85: attaching the RIGHT arm on the drive nut assembly

(for action 4-6 see image 86)
4. Place the six hex nuts 3mm in the slots of the wooden panel with
adjustable level screws.
Move the parts into each other.
6. Attach the parts together.
Use six bolts M3 x 30mm.

o

image 86: assembling the Z stage assembly

If done correctly, the result must look like this, see image 87.

image 87. result of the Z stage assembly

Step 4: finishing the Z stage assembly Assembling the Z stage
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6.4.5. Step 5: Applying tape to the bed
The following parts are needed in this step.

Letter | Description Qnty. | Letter | Description Qnty.

Q acrylic print platform 1 @ blue tape 1

0 ®

Ll

image 88 parts needed for this step

To prepare the bed for its first print, perform the following actions.
1. Remove the protection foil from both sides of the acrylic.
2. Put blue tape strokes on top of the surface, see image 89.
ﬂ Notice: place the tape strokes next to each other, NOT over each
other.
ﬂ Notice: place the strokes in the same directions as shown in image 89.
3. Cut the blue tape by running a knife through the length of the groove
that is engraved in the acrylic, see image 90.
4. Remove the excess part of the tape.

68 Step 5: Applying tape to the bed Assembling the Z stage




image 89: placing tape strokes

o

.

image 90: cutting the tape strokes

5. Place the acrylic print platform on the wooden subassembly by sliding
it over the adjustable level screws, see image 91.

image 91: placing the acrylic print platform

Step 5: Applying tape to the bed Assembling the Z stage




6.4.6. Step 6: installing the Z stage in the machine
The following parts are needed in this step.

Letter | Description Qnty. | Letter | Description Qnty.
O |leadscrew M8 T () |bolts M3 x 16mm 4
() |Zstage T @ |wooden parts 3B 2
® |12mm axes 2

U 2x I ax 2 X
0 (B (C_ (D (F
image 92: parts needed for this step

To install the Z stage in the machine perform the following actions.
Place the Z stage in the machine.
Move 12mm axis through the TOP panel, and through the linear bearing
of the Z stage, see image 93.
Move the 12mm axis further, through the BOTTOM panel, see image 93.
Do the same for the second 12mm axis, see image 93.

Attach wooden part 3B on top of the 12mm axes.

Use two bolts M3 x 16mm for each wooden part 3B.

1.
2.

H o
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image 93: attaching the 12mm axes

6. Attach the leadscrew M8 through the drive nut, see image 94.
Tip: grease the leadscrew with magnalube, see for more information
paragrapgh 6.4.7.

7.  Attach the two screws on the coupling with a hex key, see image 95.

image 94. attaching the leadscrew M8 trough the drive nut

Step 6: installing the Z stage in the machine Assembling the Z stage 71
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image 95: Attaching the screws with a hex key

The frame is now ready!

6.4.7.

Step 7: greas it up

The following parts are needed in this step.

Letter

Description

Qnty.

magnalube tube

To grease the leadscrew, perform the following actions.

1.

2.

Put a droplet of the supplied tube of grease on your finger (a volume

comparable with a Sportlife gum).

Spread the droplet across the ledscrew (on straight line from top to

down is fine).

Notice: the drive nut will spread the grease later, when the leadscrew

rotates.
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 ASSEMBLING
THE MATERIAL
FEEDER

WHAT YOU’'LL NEED TO
ASSEMBLE THE MATERIAL
FEEDER.

Time:
about 30 to 40 minutes.

Tools:

hex keys (2mm)
adjustable wrench (has to fit M8nuts or pliers)
small screw driver (2mm)
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6.5.1. Step 1: drive mechanism main body assembly
The following parts are needed in this step.

Letter | Qnty. | Description Letter | Qnty. | Description
Q 1 wooden part T0A G 1 stepper motor
(B) 1 wooden part 10B (G) 2 | hex nuts 3mm
® 2 |wooden part 10C (H) 6 |bolts M3 x 20mm
(D] 1 quick fit coupling (| ] 2 ball bearings 8mm
() 1 small black gear

2 X

image 96. parts needed for this step

To assemble the extrusion head housing, perform the following actions.
1. Move the small black gear over the motor axis, see image 97.
ﬂ Notice: make sure the small black gear is placed on the top motor
axis, so the motor axis does not sticks out.
2. Place a ball bearing 8mm in the hole of the wooden part 10A.
3. Place a ball bearing 8mm in the hole of the wooden part 10C, see
image 98.

74 Step 1: drive mechanism main body assembly Assembling the material feeder




image 97: moving the small black gear over the motor axis

image 98: placing the ball bearings 8mm in the wooden part 10A and the wooden

part 10C

© ~ o o [l

(for action 4-9 see image 99)

Place wooden part TOA on top of the motor.

Notice: make sure the engraving is facing the motor.

Place the wooden part 10B on top of the wooden part 10A.

Place the quick fit coupling in the T-slot.

Place the wooden part 10C on top of the wooden part 10B.

Attach the wooden parts A, B and C on the motor.

Use four bolts M3 x 20mm.

Place two bolts M3 x 20mm near the ball bearings 8mm and lock with
two hex nuts 3mm.

Step 1: drive mechanism main body assembly Assembling the material feeder 75



image 99: mounting different parts on the motor

6.5.2. Step 2: drive bolt assembly
The following parts are needed in this step.

Letter | Description Qnty. | Letter | Description

Qnty.

wooden gear
0

1 washers M8
(engraved extrude) @

3x %

obbe olt cap nut
() |hobbed bol 1 M8 1
ex nut elrin clip
® |h M8 T delrin cli 1
(B (C
6 ®

image 100: parts needed for this step
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To make the drive bolt assembly, perform the following actions.

o [

(for action 1-8 see image 101 and image 102)

Place the delrin clip on the groove of the hobbed bolt.

Move the hobbed bolt through the ball bearings 8mm.

Notice: check if the ‘good’ gripping part of the drive bolt is
positioned straight between the two wooden parts. If not, consider
to attach the wooden parts of the drive mechanism main body a little
more tight.

Place the hex nut M8 inside the wooden gear.

Place two washers M8 over the hobbed bolt.

Attach the wooden gear on the hobbed bolt

Notice: Do not attach too tight. Check if the gear can rotate freely in
the ball bearings 8mm.

Place a washer over the hobbed bolt, on top of the wooden gear.
Place the cap nut M8 loosely on the hobbed bolt.

Now carefully tighten the cap nut M8 and the wooden gear. Be sure
the hobbed bolt is able to rotate in the ball bearings 8mm.

Notice: do not force!

Check if the motor with the small black gear makes contact with the
wooden gear. Adjust if necessary.

Notice: make sure the small black gear and wooden gear are not
under pressure.

Notice: you can use the small hole in the wooden gear to adjust the
motor if it is not alligned correctly

image 101. assembling the drive bolt assembly (1)

Step 2: drive bolt assembly Assembling the material feeder
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image 102:

result of the drive bolt assembly (2)

6.5.3.

Step 3: clamp assembly
The following parts are needed in this step.

side plate A

Black Lever

Letter | Description Qnty. | Letter | Description Qnty.
() |U-Bracket T () |[bolts M3 x 20mm 3
() |black wheel T @ |spring 1
® |mounting plate 1 @® |hex nut3mm 1
() |bolts M3 x 16mm 6 (@ |sideplateB 1
G |washer T ® |[bolts M3 x 25mm 1
Q ball bearing 8mm 1 @ |lock nuts 7
(G (]
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image 103: parts needed for this step

To make the clamp assembly, perform the following actions.
1. Push the ball bearing 8mm in the black wheel, see image 104.
Tip: use a piece of reduntant wood to apply more force if needed.
2. Place a hex nut 3mm in the T-slot of the mounting plate, see image 105.

(for action 3-5 see image 106)
3. Place the black wheel (with ball bearing 8mm) in the mounting plate.
4. Place two side parts over the mounting and attach the parts together.
Use four bolts M3 x 16mm and four lock nuts.
ﬂ NOTICE: mind the orientation.
5. Place ONE bolt M3 x 20mm through the ball bearing 8mm and tighten
loosely.
Use ONE lock nut.

Step 3: clamp assembly Assembling the material feeder 79



image 104: pushing the ball bearing 8mm in the black wheel

image 105: placing a hex nut 3mm in the mounting plate

image 106: placing the side plates over de mounting plate

6.
7.

Place the U-Bracket on side of the clamp assembly, see image 107.
Attach a spring and a washer on the hole of the U-Bracket.
Use a bolt M3 x 25mm.
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ﬂ Notice: because you have to push the spring, it can take some force.
ﬂ Notice: the spring should stick out about TTmm.
ﬂ Notice: If it is hard to reach. Try without the spring first.

I

image 107: placing the U-Bracket on the clamp assembly

The result must look like this, see image 108.

image 108: result after attaching the U-Bracket on the clamp assembly

(for action 9-10 see image 109)
8. Attach the clamp assembly with U-Bracket on the main body of the
drive mechanism.
Use ONE bolt M3 x 20mm and ONE lock nut.
Notice: do not screw too tight, the clamp assembly with U-Bracket
must be able to move.
Notice: make sure the lock nut is NOT placed on the side of the gear.
Connect the lever to the main body of the drive mechanism.
Use ONE bolt M3 x 20mm and a ONE lock nut.
Notice: do not screw too tight, it must be able to move.
Notice: make sure the lock nut is NOT placed on the side of the gear.

ol
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image 109: attaching the clamp assembly with U-Bracket and the lever on the main
body of the drive mechanism

The result must look like this, see image 110.

image 110:  result after attaching the clamp assembly with U-Bracket and lever on the
main body of the drive mechanism

6.5.4. Step 4: attaching the feeder to the machine
To attach the feeder to the machine, perform the following actions:

1.

2.

W

Attach the feeder in the slots of the BACK panel, see image 111

Place the bow shaped tube in the tube couple of the material feeder
mechanism.

Secure the bow shaped tube with a blue horse shoe.

Move the wires from the material feeder through the hole below the
material feeder of the BACK panel.

Move the wires through the corner hole of the BOTTOM panel.
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image 111:  attaching the clamp assembly with U-Bracket and lever on the main body

of the drive mechanism

6.5.5. Step 5: assemble the filament holder
The following parts are needed in this step.

Letter | Description Qnty. | Letter | Description Qnty.

Q wooden parts 11B 2 @ wooden parts 11C 4

o Ly L

0 2 X

image 112:  parts needed for this step

To assemble the filament holder, perform the following actions.
1.  Position two wooden parts 11B next to each other.
2. Push the four wooden parts 11C in the slots of the two wooden parts
11B, see image 13.
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image 113:  pushing the wooden parts 11C in the slots of the wooden parts 11B

3. Place the filament holder in the slots in the BACK panel, see image 114.

image 114: attaching the filament holder in the BACK panel
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- MOUNTING THE

ELECTRONICS
CIRCUIT
BOARD

WHAT YOU’'LL NEED TO
MOUNT THE ELECTRONICS
CIRCUIT BOARD.

Time:
about 30 to 60 minutes.

Tools:

hex keys (2mm)
tiny flat screwdriver
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What you need to know before you start attaching the electronics.

The electronics simply need to be attached to the machine and a few wire
connectors plugged in. For extra safety, there’s also a cooling system under
the electronics that will reduces the chance of problems. The stepper drivers
can get hot, and if they would overheat, a thermal fuse will turn them off. The
cooling system will allow the machine to work in a warm environment or allow
you to set the current slightly higher than usual.

Warning! When handling electronics make sure that you are not
statically charged. This can permanently damage your electronics.

6.6.1. Step 1: mounting the electronic circuit board
The following parts are needed in this step.

Letter | Description Qnty. | Letter | Description Qnty.
electronic circuit
bolts M3 x 30mm 4 1
Q G board
() |threaded spacers 4 () |tube spacers 4
4%
(A (D) D 4 x

image 115:  parts needed for this step
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To attach the electronic circuit board, perform the following actions.

(for action 1-4 see image 116)

1.  On the BOTTOM panel put four bolts M3 x 30mm from INSIDE towards
OUTSIDE.

2. Place the tube spacers over the four bolts M3 x 30mm.

3. Place the electronic circuit board over the bolts M3 x 30mm, on the
tube spacers.

4. Secure with four threaded spacers.

Uiﬁé;éaﬁ«@r

image 116.  mounting the electronics circuit board

6.6.2. Step 1: preparing the electronic cooling system
The following parts are needed in this step.

Letter | Description Qnty. | Letter | Description Qnty.
wooden electronic
cooling fan 1 1
o d e panel
() |cooling duct sheet T @ |bolts M3 x 30mm 2
(® |blue scotch tape T (©® |bolts M3 x 12mm 5
() |wooden cover panel 1 () |hex nuts 3mm 7
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1x 1x

1x

image 117:  parts needed for this step

To prepare the electronic cooling system, perform the following actions.
1.  Attach the fan to the side that is not marked, see image 118.

Use two bolts M3 x 30mm and two hex nuts 3mm.

aoA NN

Attach the wooden air-duct cover, see image 122.
Use five bolts M3 x 12mm and five hex nuts 3mm.

Fold the cooling duct sheet along the perforations, see image 119.
Place the cooling duct sheet over the wooden panel, see image 121.
Turn the assembly over (you will face the engraved side now).

Notice: make sure you fasten very tight (but do not force it).
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image 118:

mounting the fan

image 119:  folding the cooling duct image 120. folding the cooling duct sheet
sheet sideview 1. side view 2.
image 121:  placing the cooling duct sheet

Step 1: preparing the electronic cooling system Mounting the electronics circuit board
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image 122: attaching the wooden air-duct cover

image 123: putting blue tape on the hex nuts 3mm

6. Put blue tape on the hex nuts 3mm, see image 123.

ﬂ Notice: you have to perform this action to isolate the bolts M3 x 12mm
electrically.

Tape the tiny gaps around the cooling duct sheet.

Notice: you have to perform this action to prevent unwanted air leaks.
Connect the cooling fan to the (always on) 12V power output,

o [~
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6.6.3. step 3: connecting the heater
To connect the heater, perform the following actions.

1.  Connect the WHITE wires of the heater element to the terminals of the
heater 1 output, see image 125.
Notice: do not strip the wires too much. This can cause short circuit.
Notice: do not strip the wires too short. This can cause no contact.
Attach the terminals.
Use a small screwdriver.
Notice: make sure the cable is secure.

NI - | =

image 124: connecting the heater

step 3: connecting the heater Mounting the electronics circuit board
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6.6.4.

Step 4: connecting the print head electronics

The following parts are needed in this step.

Letter

Description Qnty.

Black electronic cable with 3 tiny plugs on both sides 1

To connect the print head electronics, perform the following actions

1.

From the bottom of the machine, guide the three tiny plugs through
the RIGHT BACK corner of the machine.

Notice: the side with the three smaller plugs shoud be connected to
the print head.

Guide the three tiny cable plugs through the cable duct.

Plug the RED/BLACK fan connector of the extruder head in the BLUE/
PURPLE connector of the black cable.

Plug the RED/BLACK/YELLOW connector (with the dot) on the white
connector of the extruder head (tiny circuit board), see image 126.
OPTIONAL: when you make use of dual extrusion, plug the GREEN/
ORANGE/BROWN connector on the second connector.

image 125:  plugging in the print head connectors

o

Turn the machine on its side.

Plug in the BLUE/PURPLE plug in the connector called FAN
PRINTHEAD on the circuit board.

Plug in the RED/BLACK/YELLOW plug in the connector called TEMP1
on the circuit board.

Plug in the GREEN/ORANGE/BROWN plug in the connector called
TEMP2 on the circuit board.
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6.6.5. Step 5: connecting the limit switches
To connect the limit switches, perform the following actions.

1. Connect the plug of BLACK wired limit switch (1) to the connector (1)
on the circuit board.
The BLACK wired limit switch (1) is situated behind a hole in the
BOTTOM plane.

2. Connect the plug of BLACK wired limit switch (2) to the connector (2)
on the circuit board.
The BLACK wired limit switch (2) is situated at the TOP of the machine.

3. Connect the plug of RED wired limit switch (3) to the connector (3) on
the circuit board.
The RED wired limit switch (3) is situated at the BACK of the machine.

4. Connect the plug of RED wired limit switch (4) to the connector (4) on
the circuit board.
The RED wired limit switch (@) is situated at the FRONT of the machine.

5. Connect the plug of BLUE wired limit switch to the connector called
FRONT RIGHT on the circuit board.
This BLUE wired limit switch situated at the RIGHT of the machine.

6. Connect the plug of BLUE wired limit switch to the connector called
FRONT LEFT on the circuit board.
This BLUE wired limit switch situated at the LEFT of the machine.

6.6.6. Step 5: connecting the motors
To connect the motors, perform the following actions:
1. Connect the plug of X motor to the connector called X motor on the
circuit board.
The X motor is mounted on the BACK plane inside the machine.
2. Connect the plug of Y motor to the connector called Y motor on the
circuit board.
The Y motor is mounted on the LEFT panel inside the machine.
3. Connect the plug of Z motor to the connector called Z motor on the
circuit board.
The Z motor is mounted on BOTTOM panel under the machine.
4. Connect the plug of EXTRUDER-MOTOR to the connector called
EXTRUDER-MOTOR on the circuit board.
The EXTRUDER-MOTOR is mounted on the EXTRUDER outside the
machine
Notice: check the connections you have just made.
Notice: if you have the Ulticontroller, assemble it before going to the
next paragraph. How to assemble the UltiCotroller is described in
chapter 6.7.
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6.6.7.

Step 7: mounting the electronics cooling system

The following parts are needed in this step.

Qnty.

Description

4

bolts M3 x 10mm

To mount the electronic cooling system, perform the following actions.

(for action 1-4 see image 127)

Attach the bolts M3 x TOmm into the white threated spacers, but not
all the way.

Place the cooling assembly over the bolts M3 x TO0mm.

Move the cooling assembly.

The bolts M3 x 10mm must end in the smallers parts of the slots.
Attach the bolts M3 x TO0mm slightly more, till they touch the wood.

image 126. mounting the electronic cooling system

6.6.8.

Step 7: strain relief

To achieve strain reliefs, perform the following actions.

1.

Guide the cables (black cable and the white cables connected to the
extrusion) through the strain relief.

Tip: the strain relief is the strain relief plate on top of the extrusion
head.
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6.6.9.

Wrap the black cable, bow shaped tube, and the white cables (all
connected with to the extrusion head) together in transparant wire
wrapping.

Goal is to get a tidy cable.

Wrap all cables together at the underside of the BOTTOM plate.
Use the velcro strips.

Step 9: checking and aligning the top-Z limit switch

Notice: this is de MOST important end-stop of the machine. It’s
important that the starting height is about O, iImm above the acrylic
platform.

To check and align the top-Z limit switch, perform the following actions:

10.

1.

12.

(for action 1-12 see image 128)

Turn the leadscrew until the extrusion head is almost touching the
acrylic platform.

Tip: it must be possible to move ONE A4 paper between the nozzle
and the acrylic platform. TWO A4 papers must NOT be possible.
Move the extrusion head to the FRONT LEFT corner.

Screw OUT the FRONT LEFT adjustment bolt till the acrylic platform
touches the nozzle.

Screw IN the FRONT RIGHT adjustment bolt.

Move the the extrusion head rom the FRONT LEFT to the FRONT
RIGHT corner.

This must be possible without making scratches. Otherwise, screw IN
the FRONT RIGHT adjustment bolt a little more.

Screw OUT the FRONT RIGHT adjustment bolt till the acrylic platform
touches the nozzle.

Screw IN the BACK RIGHT adjustment bolt.

Move the the extrusion head rom the FRONT RIGHT to the BACK
RIGHT corner.

Screw OUT the BACK RIGHT adjustment bolt till the acrylic platform
touches the nozzle.

Screw IN the BACK LEFT adjustment bolt.

Move the the extrusion head rom the BACK RIGHT to the BACK LEFT
corner.

Screw OUT the BACK LEFT adjustment bolt till the acrylic platform
touches the nozzle.

Step 9: checking and aligning the top-Z limit switch Mounting the electronics circuit board
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image 127 alligning the acrilic platform with the extrusion head

13. Loosen the bolts slightly of the top-Z limit switch (2).
You must be able to move the switch up and down.

14. Turn the lead screw to elevate the acrylic platform until the nozzle of
the extrusion head almost touches the platform.

15. Lower the limit switch.

16. Attach one side of the limit switch.

17. Move the other side.
Notice: the limit switch will rotate a little.

18. Rotate the switch till you hear a click.
The switch is now closed.

19. Attach the other side of the limit switch slightly.
If you do not hear the click. Release the other bolt and lower the
switch a little more till it clicks.

20. Attach the bolts tight.

ﬂ Notice: the switch shouldn’t move anymore.

ﬂ Notice: when you are using the control software for the first time, test
the response to the limit switches. Especially the top-Z limit switch.

Step 9: checking and aligning the top-Z limit switch Mounting the electronics circuit board




 ASSEMBLING AND
CONNECTING THE
ULTICONTROLLER

WHAT YOU’LL NEED TO
ASSEMBLE AND CONNECT
THE ULTICONTROLLER.

about 10 to 20 minutes.




6.7.1. Step 1: assembling the Ulticontroller
The following parts are needed in this step.

Letter | Qnty. | Description Letter | Qnty. | Description

(A 1 Ulticontroller BACK (F ) 1 Ulticontroller LEFT
(B) 1 display v1.0 (G) T Ulticontroller RIGHT
® 4 |tube spacer (H) 4 | bolts M3 x 25mm
(D] 4 |bolts M3 x TOmm (| ] 10 |hex nuts 3mm
E) 1 Ulticontroller FRONT () ) 1 button

o . Ulticontroller PCB

Connection Cable

4 x

T@34 x

4 x

image 128: parts needed for this step

To assemble the ultiontroller, perform the following actions.
1. Remove the foil from the display V1.0 (if present).
2. Remove the protective sticker from the piezo speaker (if present).
3. Attach the display v1.0 to the Ulticontroller FRONT, see image 130.
Use four bolts M3 x 25mm, four tube spacers and four hex nuts 3mm.
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image 129: mounting the display v 1.0 to the Ulticontroller FRONT

(for action 4-8 see image 131)
4. Turn the controller on its front.
5. Plug both of the PCB connector cables into the connectors.
plug cable 1 into connector 1. plug cable 2 into conncetor 2.
6. Place six hex nuts 3mm inside the slots of the Ulticontroller BACK.
Tip: Use tape to keep the hex nuts 3mm in position.
7. Attach the Ulticontroller BACK onto the Ulticontroller FRONT,
Use two bolts M3 x 10mm at the long sides.
8. Attach the side parts.
Use two bolts M3 x 10mm for every side.

image 130. mounting the back plate and the side parts

9. Put the button in place, see image 132.
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image 131:  placing the button

6.7.2.

Step 2: connecting the controller

To connect the Ulticontroller, perform the following actions.

Be Nooasan -

Turn off the Ultimaker Original.

Disconnect the electronic cooling system.

Guide the cables through the hole in the BOTTOM panel.

Connect the cable

Place back the Electronics cooling system.

Put the Ulticontroller on the lower part of the FRONT panel.

Turn the power on.

Insert the SD-card.

Notice: check for firmware updates and information the Software
setup guide.

Congratulations! You are ready to print now.
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7 Usage of the Ultimaker Original

 USING THE
ULTIMAKER
ORIGINAL FOR
THE FIRST TIME




We recommend you to use supplied software, but feel free to use different
types of programs if you feel like you are up to it, or just simply disagree.
Playful experimenting and innovating is what made Ultimaking B.V. to what it is
today.

There are 2 different types of software that you will need to get your Ultimaker
printing. Some software have these combined, others do not.

First you need a slicer to create the file that containes all the parameters of a
print, called the Gcode. Secondly you need software to sent this Gcode to your
Ultimaker. In the beginning you most likely will download a file from the world
wide web to print. Plenty of these files can be found on websites like www.
youmagine.com.

One of the files that is printable is called a STL.

71.1. Slicer software

As a slicer we can recommend you to use:
-Cura

-Slic3r

-Kisslicer

-Netfabb

The basic idea of slicing is that it converts a printable file (STL) to a code that
contains all the information to create your print. We will take you along to
create a Gecode, to print with PLA.

Cura
1. Go to our website menu ‘community’
2. ‘download’ for the latest version of Cura.
3. Open Cura
4. Go to Expert > Install default Marlin Firmware.
5. Use the default STL
6. Go to Tools > Switch to Quickprint.
7.  Choose High Quality Print, and PLA.
8. If asked, enter the diameter of your filament.
ﬂ Notice: The filament should be approximately 2.85mm, but it may
vary 0.7mm.
ﬂ Notice: If you do not have digital calipers, enter a number between
2.85-2.90mm.
ﬂ Notice: You do not have to tick ‘Print Support Structure’.

Is the Ultimaker Original connected with the computer, go to action 9.
If it’s not. Go to action 10.
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Via the computer
9. If the Ultimaker is connected with the computer, click ‘Print’.

Via the Ulticontroller
10. Save the file on your SD-card.
1. Insert the SD-card into the slot on the LEFT of the Ulticontroller.
On the display v1.0, it should say, ‘Card inserted’.
12. Rotate the navigation wheel.
13. Select ‘Print’ or ‘Card menu’.
14. Select the file you want to print.

Netfabb

1.  Download a STL, for example: http://www.thingiverse.com/thing:13588

2. Go to Project > Open and select the file you want to print.

3. Click the small cross next to ‘Parts’ (in top RIGHT corner), and drag the
STL file to the Ultimaker tab. If you do this correctly the file will appear
on a build platform interface.

4. If there are any issues with it then NetFabb will prompt you to
automatically fix it... Do that.

5. Select either No raft, or Outline. Outline will put a box around the print
and is good for getting your plastic flowing smoothly at the start. Any
other raft is generally not necessary.

6. Under ‘Current Part’ click on ‘Center’ to put your object in the middle
of the platform (or move it to where you’d like to print).

7. Select your print quality (that’s the build style) and under ‘extruder’
select the machine settings profile. Make sure you’re profile match up
for the standard profiles (i.e. if you use the Ultra profile in one then use
the Ultra profile for the other... They’re designed to go together).

8. Set the fill spacing slider to something like 2.5-4mm to start with. If
you cannot move the slider (it’s greyed out) then make sure your part
is selected on the bed by clicking on it.

9. Hit ‘Calculate toolpath’... That will do the slicing.

Slicer software Using the Ultimaker Original for the first time 103




Directly via the computer

1.

9.

10.

1.

When the Ultimaker is connected with the computer just hit print to
print it.

Download Pronterface/Printrun. For windows https://github.com/
kliment/Printrun. For mac http://koti.kapsi.fi/~kliment/printrun/
pronterface-mac-Mar2012.zip. Because Netfabb cannot communicate
with the Ultimaker.

Scroll down to the bottom of the page and click Windows >
Precompiled version.

Download Printrun-win, and unpack pronterface.zip. Now you can
open Pronterface.

Connect your Ultimaker via an USB port and chose the RIGHT port
from the list.

It is most likely tty.usb.something. Feel free to try several ports if you
can not find it, nothing bad can come from this.

Set baudrate to:

57600 if you are running the default firmware (5D).

250000 if you are running Sprinter or Marlin firmware.

Click connect. If your printer doesn’t connect, chose a different usb
port. Make sure you have turned on your Ultimaker.

Go to File > Open and select the Gcode you want to print.

Preheat the nozzle of the Ultimaker to 180°C.

Click ‘Print’.

Via the Ulticontroller

1.

W

To print it with the Ulticontroller, save your gcode to SD card for
example.

Place the SD card into the SD slot on the LEFT of your Ulticontroller.
On the screen it should say, Card inserted.

Press the navigation wheel, go to card menu and select the file you
want to print.

Your Ultimaker will go ‘home’ heat up to the RIGHT temperature and
calculate a path and start to print.
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